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2018 ULTRATAX/1065 PROFORMA & BUSINESS ORGANIZER, v.2018.1.0 
User Bulletin 1065US-18.1.0: Initial Release 
 
November 19, 2018 

 
This release contains a fully functional federal 1065 application, which is used to proforma client data 
and produce Business Organizers.  
 
Many of the forms included in this release are preliminary or prior-year versions and are subject to 
change. As a result, final testing of all federal calculations has not been completed. Therefore, we 
recommend that, beyond proforma processing and producing Business Organizers, you do not use this 
release to prepare your returns. The December release will include fully tested calculations for any 
government forms received. 
 

PROFORMA 
Client documents 

Due to changes to add tax due and overpayment remittance sections, to remove references to Form 
1065-B, to replace tax matters partner (TMP) with partnership representative (PR), and to modify the 
signature sections for changes in partnership return signature requirements, proforma of the following 
client documents is not available.  
▪ Partner Transmittal Letter 
▪ 1065 Email K-1 Package Greeting 
▪ Partner K1 Enclosed (TL) Custom Paragraph 
▪ Elec Funds Withdrawal (TL) Custom Paragraph 
▪ Elect Out of Sub K Provisions Election 
▪ Form 1065 Return, Extension, and Amended Instructions 
▪ Form 2848 Instructions  
▪ Form 3115 Instructions  
▪ Form 8716 Instructions  
▪ Form 8752 Instructions and Amended Instructions 
▪ Form 8804 Instructions and Amended Instructions 
▪ Form 8821 Instructions 
▪ Form 8822-B Instructions 
▪ FinCEN Form 114 Instructions and Amended Instructions 
▪ Bank Account Verification Instructions 
 
Due to tax law changes, the following client documents are no longer applicable and proforma of them 
has been removed. 
▪ Technical Termination (TL) Custom Paragraph 
▪ 1065 Consolidated Audit Rule Election 
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Form 1065-B 

Public Law 114-74, Title XI, section 1101(b), repealed the electing large partnership rules for partnership 
tax years beginning after 2017. Form 1065-B and its related forms and schedules are obsolete and have 
been removed from the application. Any clients that filed Form 1065-B in 2017 will automatically be 
changed to file Form 1065 during proforma. 
 
Schedule K depreciation 

The Tax Cuts and Jobs Act (TCJA) suspended miscellaneous itemized deductions subject to 2% limitation, 
including some portfolio deductions. In prior years, UltraTax CS classified expenses related to portfolio 
assets (depreciation, amortization, start-up expenses, organization costs, and lease inclusions) as 
portfolio deductions subject to the 2% limitation. To aid in calculating state conformity differences, the 
Treat Schedule K depreciation as portfolio deductions (other) field has been added to Screen CltOptns. 
When marked, these expenses will be classified as Portfolio deductions (other) and included in Schedule 
K, line 13, Other deductions. When blank, these expenses will not be included in the federal return; 
however, the amounts will be available for state calculations.  
 
UltraTax/1065 can mark the option in Screen CltOptns automatically. The option is marked differently 
depending on whether the client is an existing client being proforma’d from the prior year or a new 
client subsequently added to the application.  
▪ Existing clients being proforma’d: Select the Treat Schedule K depreciation as portfolio deductions 

option in the Setup > 1065 Partnership > Other Return Options > Proforma tab. 
 
Note: The option on Screen CltOptns marks during client proforma. Therefore, the option on the 
Proforma tab in Other Return Options dialog must be marked before you proforma the client. 
 

▪ New clients subsequently added: Select the Treat Schedule K depreciation as portfolio deductions 
option in the Setup >1065 Partnership > New Client Options > Return Presentation tab. 

 
Print collations 

We recommend you do not customize or proforma form print collations with this release. The 
December release of UltraTax/1065 will include changes for released government forms, which may 
cause UltraTax CS to override any form print collation customizations you complete with this release. 
 
State data 

When you receive and install your state applications on a later release, UltraTax CS will automatically 
proforma the prior-year UltraTax/1065 state data as you process returns for each client. 
 

BUSINESS ORGANIZER 
This release of UltraTax/1065 includes the Business Organizer, a powerful feature that allows you to 
create and send professional Business Organizer packages to your clients. The Business Organizer 
includes both a questionnaire and a Microsoft® Excel® spreadsheet.  
 
For more information, see the following. 
▪ See Business Organizer frequently asked questions for more information on the Business Organizer. 
▪ If you want to deliver the Business Organizer to your clients via Email PDF, see Email Business 

Organizer overview for more information. 
▪ If you want to deliver the Business Organizer to your clients via NetClient CS, see Web Business 

Organizer overview for more information.  

http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/utwapp/borg/business-organizer-overview-procedures.htm
http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/utwapp/borg/faq/business-organizer-frequently-asked-questions.htm
http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/utwapp/borg/ebo/business-organizer-email-procedures.htm
http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/utwapp/borg/ebo/business-organizer-email-procedures.htm
http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/utwapp/borg/wbo/business-organizer-web-procedures.htm
http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/utwapp/borg/wbo/business-organizer-web-procedures.htm
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The following changes were made to the 2018 UltraTax/1065 Business Organizer Questionnaire. 
▪ Questions referring to tax matters partner were changed to partnership representative. 
▪ Questions were added to ask if any foreign individual, entity, or trust partners exist and whether any 

withholding was made for the partners. 
 

CHANGES  
This release includes the following changes in reaction to the Tax Cuts and Jobs Act (TCJA). 
▪ Added Nondeductible entertainment and Nondeductible expenses subject to 2% fields on Screen 

M1M2 in the Balance Sheet folder.  
▪ Added Entertainment and Nondeductible expenses subject to 2% fields to Screen M3-3 in the 

Balance Sheet folder. 
▪ Added Screen QBI in the Income & Deductions, Farm, Farm Rent, and Rent folders to calculate the 

Partner’s Section 199A Information Worksheet. 
▪ Added Screen 965 in the Schedule K folder. 
 
This release includes the following changes from the prior year version of UltraTax/1065. 
▪ IRS Service center for paper filed partnership returns has changed for the following states. 

▪ Partnerships located in Connecticut, Delaware, District of Columbia, Indiana, Maine, Maryland, 
Massachusetts, New Hampshire, New Jersey, New York, North Carolina, Ohio, Pennsylvania, 
Rhode Island, South Carolina, Vermont, Virginia, and West Virginia are filed in Kansas City, MO if 
the total assets at the end of the year are less than $10 million and Schedule M-3 is not filed. 

▪ Partnerships located in Florida are filed in Ogden, UT. 
▪ Tax Matters Partner (TMP) has changed to Partnership Representative (PR). Additionally, if the 

Partnership Representative is not an individual, a Partnership Representative Designated Individual 
(PRDI) should be entered. Both the PR and PRDI, if applicable, must have a US address. Data entry 
on Screen Contact in the General folder and on the Partner tab in View > Partner Information has 
changed accordingly. 

▪ The name of the person signing the return and the name of the partnership representative 
designated individual both changed from one 35-wide name field to separate first name and last 
name fields, 14-wide and 20-wide respectively. Data entered in the prior year fields will proforma to 
the new separate fields. Review proforma’d data on Screen Contact in the General folder. 

▪ The Extension and Late Filing Penalty sections, formerly on Screen 1065, have moved to new Screen 
Pmt in the Payments folder. 

▪ Added fields to Screens K and K1 for dividend equivalents not included in ordinary dividends. 
▪ Personal use rental expense reported on schedule M-1/M-3 does not include personal use portion 

of tax credit adjustments. 
 

ENHANCEMENTS 
The following calculating forms and schedules were added to 2018 UltraTax/1065. 
▪ Form 965, Inclusion of Deferred Foreign Income Upon Transition to Participation Exemption System 
▪ Form 8994, Employer Credit for Paid Family and Medical Leave 
▪ Schedule B-2 (1065), Election Out of the Centralized Partnership Audit Regime 
 
The following worksheets and reports were added to 2018 UltraTax/1065. 
▪ Partner’s Section 199A Information Worksheet 
▪ Qualified Property Report 
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The following non-calculating forms and schedules were added to 2018 UltraTax/1065. 
▪ Form 8697, Interest Computation Under the Look-Back Method for Completed Long-Term Contracts 
▪ Form 8866, Interest Computation Under the Look-Back Method for Property Depreciated Under the 

Income Forecast Method 
▪ Form 8904, Credit for Oil and Gas Production From Marginal Wells 
▪ Form 8979, Partnership Representative Revocation, Designation, and Resignation Form 
▪ Form 8992, U.S. Shareholder Calculation of Global Intangible Low-Taxed Income (GILTI) 
▪ Form 8996, Qualified Opportunity Fund 
▪ Schedule A (965), U.S. Shareholder’s Section 9659a) Inclusion Amount 
▪ Schedule B (965), Deferred Foreign Income Corporation’s Earnings and Profits (E&P) 
▪ Schedule C (965), U.S. Shareholder’s Aggregate Foreign Earnings and Profits Deficit 
▪ Schedule D (965), U.S. Shareholder’s Aggregate Foreign Cash Position 
▪ Schedule E (965), U.S. Shareholder’s Aggregate Foreign Cash Position - Detail 
▪ Schedule F (965), Foreign Taxes Deemed Paid by Domestic Corporation (2018 tax year) 
▪ Schedule G (965), Foreign Taxes Deemed Paid by Domestic Corporation (2017 tax year) 
▪ Schedule H (965), Amounts Reported on Forms 1116 and 1118 and Disallowed Foreign Taxes 
 
The following features were added to 2018 UltraTax/1065. 
▪ Other Return Option to treat Screens Rent subsequently added to a client as rental real estate  
▪ 8804 Instructions added reference to include Form 8804-C(s) in the “Other” paragraph 
▪ Slipsheet for the Engagement Letter 
▪ Multi-field custom fieldview behavior added to US and foreign address entry for partners in View > 

Partner Information 
▪ Taxes and payments can now be remitted with Form 1065. Enter information for taxes due in new 

Screen Tax in the Taxes folder and payments in new Screen Pmt in the Payments folder. 
 

ULTRATAX CS ELECTRONIC FILING UTILITY  
The UltraTax CS Electronic Filing utility will be included in the January 2019 release of UltraTax/1065. 
Refer to User Bulletin 1040US-18.1.0, Electronic Filing Setup Procedures for information about setup 
issues and other information you may need to address prior to electronically filing 1065 returns with 
UltraTax CS.  
 

ENHANCEMENTS TO 2018 ULTRATAX CS  
To learn more about enhancements to UltraTax CS products in general, such as enhancements to the 
sign-in authentication process for a better user experience, the printing current and related multi-page 
print option, an FYI diagnostic report of the Office Configuration dialog, and more, refer to the UltraTax 
CS Platform User Bulletin UT-18.1.0, Initial Release.  
 

HELP & HOW-TO CENTER 
The Help & How-To Center provides one-stop access to the information you need while using UltraTax 
CS. We’ve combined all content from the help system and the Support knowledgebase into a single 
repository that is hosted on our website and accessible directly from within UltraTax CS. For more 
information on the Help & How-To Center, including sample searches, see Finding answers to your 
UltraTax CS questions. 
 

http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/bulletins/i8us18_1_0_d.pdf
http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/bulletins/_8us18_1_0.pdf
http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/bulletins/_8us18_1_0.pdf
http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/utwapp/gethelp/using_help.htm
http://cs.thomsonreuters.com/ua/ut/2018_cs_us_en/utwapp/gethelp/using_help.htm

